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Getting Started 
Beginning Electronic Filing 
 
Electronic filing is: 

1. Required when a political committee or other person receives contributions or makes expenditures 
in excess of $50,000 in the current calendar year or has reason to expect to do so. 

2. Voluntary for any political committee or other person that receives contributions or makes 
expenditures less than $50,000 in the current calendar year.  However, once a committee decides 
to e-file on a voluntary basis, it must continue to do so for the remainder of the calendar year, 
unless the Commission determines that extraordinary and unforeseeable circumstances have made 
it impractical for the committee to continue filing electronically. For more information visit the 
Electronic Filing Overview page (https://www.fec.gov/help-candidates-and-committees/filing-
reports/electronic-filing/).  

 
Electronic Filing Passwords: 

Registered committees can enroll in the Electronic Filing Password Assignment System 
(https://webforms.fec.gov/psa/getstarted.htm). For further password assistance, please visit the 
Password Help page (https://webforms.fec.gov/psa/help.htm) or contact the FEC’s Electronic 
Filing Office at 202-694-1307, toll free at 800-424-9530 (menu option #4) or 
eFiletechsupport@fec.gov.  
It is important to obtain or update your password as soon as possible. Due to the extra security 
requirements, it may take up to two business days for the FEC to complete electronic filing 
password requests. 
 

Downloading Software: 
1. Go to https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/ and 

confirm Minimum System Requirements are met. 
2. Click Download FECFile.       
3. Enter the committee ID and choose Submit. 
4. Enter the required committee and contact information then click Submit. 
5. Click the FECFile X.X.X.X Download button. 
6. Follow your computer’s download instructions.   
7.  Double-click the FECFile install icon and follow the installation prompts. 

 
 
Note: FECFile will automatically check for the latest program updates every time you start the software.  

If you are having trouble downloading FECFile, please contact the FEC’s Electronic Filing Office 
at 202-694-1307, toll free at 800-424-9530 (menu option #4) or eFiletechsupport@fec.gov 

 

https://www.fec.gov/help-candidates-and-committees/filing-reports/electronic-filing/
https://www.fec.gov/help-candidates-and-committees/filing-reports/electronic-filing/
https://webforms.fec.gov/psa/getstarted.htm
https://webforms.fec.gov/psa/help.htm
mailto:eFiletechsupport@fec.gov
https://www.fec.gov/updates/tip2019-enhanced-security-e-filing-password-system/
https://www.fec.gov/updates/tip2019-enhanced-security-e-filing-password-system/
https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/
mailto:eFiletechsupport@fec.gov
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Using FECFile 
FECFile Video Tutorial: "FECFile Introduction"  
FECFile Video Tutorial: "Setting Up a FECFile Database for a Candidate" 
Creating a New Committee File 
Note: If you have an existing committee file, skip to page 6 to create a report in an existing file. 
 

1. Start FECFile using either the desktop icon or the computer’s Start Menu. 
2. Click Create a new committee file. Use the same file every time a report is created. 
3. A window will appear to confirm the creation of a new committee file. Click OK. 

 
 
 

 
 
 
 
 
 
 
 

4. Choose the committee type from the following list and click OK. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

https://www.youtube.com/watch?v=yI8AYiaOErA&index=2&list=PLJr_nRe8SzD3QT07xYhNJjvAfSCE_n7Zc
https://www.youtube.com/watch?v=9-NuHQuDgLw&list=PLJr_nRe8SzD3QT07xYhNJjvAfSCE_n7Zc&index=3
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5. Enter the committee’s ID number, name, and address.  In the 
“Authorizing Candidate” field at the bottom of the page, type the 
candidate’s name (last name, first name) and press the Tab key. 

a. A new window will open.  Enter the candidate’s 
information and click OK.  The “Campaign Committee – 
FILER” window will reappear.   

b. Enter the candidate’s information at the bottom of the 
window. When finished, click OK. 
 

6. Click Yes at the prompt. 
 

7. Click OK at the prompt. 
 
 

        
 

 
8. Enter the current election cycle.  An election cycle begins the day after the previous general 

election for that office and ends on the date of the next general election. The election cycle 
spans two years for House candidates, four years for presidential candidates, and six years for 
Senate candidates. Election cycle dates can also be entered by clicking the View menu and selecting 
Election Cycles.  Then click the Edit menu and select New. Enter the date of the day after the 
previous general election in the “Date From” field and enter the date of the next scheduled general 
election in the “Date Thru” field. Then click OK.  
To confirm that you have entered the correct election cycle dates, please contact the Reports 
Analysis Division (800-424-9530, Menu Option #5). 

2026 House Election Cycle: 11/6/2024 – 11/3/2026 
2026 Senate Election Cycle: 11/4/2020 – 11/3/2026 
2028 Senate Election Cycle: 11/9/2022 – 11/7/2028 
2030 Senate Election Cycle: 11/6/2024 – 11/5/2030 

2028 Presidential Election Cycle: 11/6/2024 – 11/7/2028 

      

https://www.fec.gov/help-candidates-and-committees/filing-reports/election-cycle-aggregation/
https://www.fec.gov/help-candidates-and-committees/question-rad/
https://www.fec.gov/help-candidates-and-committees/question-rad/
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Creating the First Report (Form 3) in a New Committee File 
1. Select the Type of Report from the Report’s drop-down menu 

and, if necessary, modify the “Date From” and “Date Thru” 
fields for the report coverage dates. 

2. Select the election cycle – make sure it is the current election 
cycle (An election cycle begins the day after the previous 
general election for that office and ends on the date of the 
next general election; please consult page 4 for more 
information). 

3. To sign the report, click in the Signed by box.  Enter the 
treasurer’s name (last name, first name).  If the treasurer has 
not already been entered into FECFile, press Tab or Enter. 

a. An “Individual/Organization” box will appear.  
Ensure that the type selected is “Individual other than 
a Candidate” and enter the rest of the treasurer’s 
information (name, address, etc.). 

b. After entering the treasurer’s information, click OK 
to return to the Report Information box. 

4. After all the information is entered, click OK. 
5. A window will appear, with options for what to do next in the report.  To view the Summary Page 

and begin to add transactions click OK.  To view the Individuals/Organizations screen, click 
Cancel. 

       

 
 
 
 
 
 
 
 
 
 

https://www.fec.gov/help-candidates-and-committees/filing-reports/election-cycle-aggregation/
https://www.fec.gov/help-candidates-and-committees/get-treasurer/
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Creating a New Report in an Existing Committee 
File 

1. In the “View” menu, click Reports. 
2. In the “Edit” menu, click New, or right click anywhere 

in the Reports window and click New. 
3. Select the report type you would like to create (Forms 3, 

6, 3L, 1, 99, or 2) and click OK. House and Senate 
committees report their financial activity on the Report 
of Receipts and Disbursements (Form F3).  

 
 
 
 

Creating a Statement of Organization (Form 1) 
1. Create a Statement of Organization by following 

the steps to create a new report as outlined in the 
previous section and choose Form 1 (Statement of 
Organization).  Click OK.  

2. The “Statement of Organization” dialog box 
appears.  Select the type of committee, and enter 
the party code, website address (if applicable), e-
mail address (required), and date. 

3. If the “Custodian of Records” and “Treasurer” 
fields (both required) do not already contain the 
names of the committee’s custodian of records 
and treasurer, click Edit. 

a. Select the custodian of records or the 
treasurer’s name from the scroll box. 
(Note: if the name does not appear in this 
box, press Tab or Enter to input that 
individual’s information.) 

b. Enter the custodian of record and 
treasurer’s phone number and 
title/relationship to the committee, then 
click OK. 

4. To enter connected organizations, affiliated 
committees, leadership PAC sponsors, joint 
fundraising representatives; designated agents; 
and banks/other depositories, click on Agents… 

https://www.fec.gov/help-candidates-and-committees/filing-reports/registering-committee/
https://www.fec.gov/help-candidates-and-committees/get-treasurer/
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a. The “Affiliations, Agents & Banks Related to the Committee” dialog box will appear. 

              
b. To add a connected organization, affiliated committee, leadership PAC sponsor, or joint 

fundraising representative, click on Affiliation… 
 

             

c. Select the name of the connected organization, affiliated committee, leadership PAC 
sponsor, or joint fundraising representative from the list. (Note: if the name of the entity 
does not appear, and press Tab or Enter to input its information.) 

d. Under “Relationship Type”, select the corresponding type of relationship then click OK. 
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5. To add a designated agent (for example, an assistant treasurer), click on Designated... 
a. Select the name of the designated agent from the list.  (Note: if the individual does not 

appear, type the name (last, first), and press Tab or Enter to input that individual’s 
information.) 

b. Enter the designated agent’s phone number and title/position with the committee, then click 
OK. 

6. To enter a bank/other depository, click Bank… 
 

    

• Select the name of the bank/other depository from the drop down box.  (Note: if the 
bank or depository does not appear, type the name, and press Tab or Enter to input its 
information.)  Click OK. 

7. To edit an entry in the “Affiliations, Agents & Banks Related to the Committee” screen, click on 
the particular entry to highlight it, then click Edit. 

8. To delete an entry in the “Affiliation, Agents and Banks Related to the Committee” screen, click 
on the particular entry to highlight it, then click Delete. 

9. After entering the information, click OK. 
10. Click OK after returning to the “Statement of Organization” box. 
11. The Form 1 is now created.  To review the Form 1 to ensure that it is complete, click the printer 

icon in the top menu bar in order to review the committee’s information.  
Note: You can also electronically file a new or amended Statement of Organization (FEC Form 1) using 
the online webform on the FEC’s website: https://webforms.fec.gov/  

   

https://www.fec.gov/help-candidates-and-committees/get-tax-id-and-bank-account/
https://webforms.fec.gov/
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FECFile Basics 
 
Saving in FECFile: 
FECFile creates a committee database (with file extension .DCf), which holds the entirety of the 
committee’s reporting history.  This includes all reports, amendments, and contributors or vendors with 
whom the committee works. 

1. Save the file as often as possible.  This will decrease the chance of massive data loss.  Be sure to 
save the file in a location easily accessible and easily remembered. The FEC cannot recover a lost 
file. The FEC strongly recommends that you frequently back up the file to an external source, 
such as a cloud storage service, a flash drive, external hard drive, or CD.  

2. For each new report, open the same committee file.  Do not create a new committee file each 
time the committee files a report.  This will lead to problems with election cycle-to-date 
amounts, cash on-hand amounts, and aggregate amounts. 

 
Using the Different Views: 
FECFile is organized into seven different views or windows: Reports; Summary Page; 
Individuals/Organizations and Events; Receipts; Disbursements; Loans, Debts, & Other Obligations; and 
All Transactions.  Each of these views displays a different aspect of reporting and is used to create and 
modify both reports and transactions.  There are three different ways to access a view:  

1. When FECFile first opens, tabs will be displayed underneath the icon bar.  Click on the tab to 
access the desired view.  Tabs can be rearranged by dragging them to another location on the tab 
bar. 
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a. In order to view two tabs side-by-side, right-click on a tab and select Open in a Horizontal 
Tab or Open in New Vertical Group. 

b. Tabs can be closed by clicking on the “X.”  New tabs can be opened or re-opened by using 
the “View” menu, clicking on the appropriate icon (please consult the next page for 
FECFile Views) or by clicking the “Window” menu and selecting “Open All” to open up 
all the tabs. 
 

2. Under the “View” menu, select the desired tab: 

     
3. Click on the icon, located across the top of the screen, representing the view: 
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About Each FECFile View: 

Reports View – This view lists all reports created in the committee file.  Transactions on these 
reports can be modified if the report is “open.”  Reports also can be amended using this view by 
right-clicking on the report and selecting Amend. 
Summary Page View – This view shows both itemized (.I) and unitemized (.U) totals for each 
line number in both the period covered (ThisP.I and ThisP.U) and the election cycle (CTD.I and 
CTD.U).  Transactions may be entered on to line numbers by double clicking a line. 

 
Individuals/Organizations and Events View – This view lists all entities entered into the 
committee database, including the committee’s information, contributors, other political 
committees, businesses, etc.  Modify an entity by double clicking on it. 
Receipts View – This view lists all receipts entered in the report currently selected in Reports 
View.  Modify a transaction by double clicking it, or right click an entry for a list of options such 
as creating a new transaction, deleting a transaction, adding memo text, etc. 
Disbursements View – This view lists all disbursements entered in the report currently selected 
in Reports View.  Modify a transaction by double clicking it, or right click an entry for a list of 
options such as creating a new transaction, deleting a transaction, adding memo text, etc. 
Loans, Debts, & Other Obligations View – This view lists all debts, loans, or other obligations 
that are owed to or by the committee in the report currently selected in Reports View.  Modify a 
transaction by double clicking it, or right click an entry for a list of options such as creating a new 
transaction, deleting a transaction, adding memo text, etc. 
All Transactions View – This view lists all transactions entered in the committee file.  
Transactions are sorted by line number and name. 

 

Memo Text: 
Memo text is used to provide additional information regarding reports and transactions.  Memo text can 
be added by highlighting the report or transaction, right-clicking, and choosing Memo Text… from the 
available options.  
 
Miscellaneous Electronic Submission (Form 99): 
A Form 99 is another way to provide additional information as a separate filing.  Go to the Reports tab 
and right-click and select New.  Then choose Miscellaneous Electronic Submission (Form 99) and click 
OK.  Enter the additional information, choose the treasurer’s name in the “Signed by” field and select 
“Miscellaneous Report to FEC” as the “Document Type.”  Follow the instructions on page 25 to upload 
the Form 99. You can also electronically file a Form 99 using the online webform on the FEC’s website: 
https://webforms.fec.gov/  
 

https://www.fec.gov/help-candidates-and-committees/filing-reports/election-cycle-aggregation/
https://webforms.fec.gov/
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Creating Contributor and Vendor entries: 
FECFile creates a database for all entities (individuals, businesses, PACs, Political Party Organizations, 
etc.) within the committee file.  This saves the committee from repeatedly entering the contributor or 
vendor information if a committee conducts multiple transactions with a particular entity. 
There are two ways to create an entity: 

1. When entering the first transaction associated with an entity, make sure the cursor is in the 
“Name” field and press Tab or Enter.  The “Individual/Organization Information” window will 
appear. 

2. Using the Individuals/Organizations view, right click anywhere in the workspace and click 
New from the available options.  The “Invididual/Organization Information” window will 
appear. 

Filling Out the Individual/Organization Information Box 
1. Select the correct entity type from the drop-down menu at the 

top of the window. 
• Note: FECFile disables any field that is not required for a type 

of entity. 
2. After entering the information, click OK. 

 
Using the FEC “Lookup” Feature: 
Click Lookup… to access the FEC’s 
database of federally registered 
candidates and political committees.  
This is an optional feature to copy 
information for a federal candidate or 
political committee instead of 
entering it in manually. 

1. In the 
“Individual/Organization 
Information” box, click 
Lookup… 

2. The “FEC ID Lookup” 
window appears.  Scroll 
through the list and click once on the entry to highlight it. 

3. Copy all applicable information by clicking Copy 
All….  
4. Unchecking boxes in the window that appears will 
exclude that information from copying to the entity 
record.  Click OK and all of the committee’s checked 
information will be copied into the entity record.   
5. Click OK to return to the transaction screen. 
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Receipts 
 
FECFile Video Tutorial: "Entering Contributions from Individuals and PACs"  

Receipt Basics 
1. Click the “Summary View” icon at the top of FECFile.  In the “Summary Page” window, double 

click on appropriate Line to enter a transaction.    
 

 
2. Click on the name in the list scroll box immediately 

beneath the name field if the entity already exists in 
the committee’s FECFile database.   If the entity is 
not in the database, press the Tab key or Enter key 
to add the information.  Refer to page 11 (“Creating 
Contributor and Vendor entries”) for more 
information. 

3. Enter date and amount and any applicable 
description of the transaction (“partnership”, for 
example). 

4. Enter the election and year of election for the 
contribution.  

5. The “Memo” box should remain unchecked unless 
the entry is providing supplemental information that  
does not affect the report’s cash on hand.  

6. The “Aggregate” box should remain checked so 
that transactions aggregate on an election cycle-to-
date basis. 

7. Click OK. 
Note: The check number and account identifier are 
NOT required fields and do not show up on a report.  
However, providing this information will allow the 
committee to keep better internal financial records. 

Receipt Reporting Examples:  

• Individual Contributions, Political Party Contributions, PACs & Other Political Committee 
Contributions, Candidate Contributions and Partnership Contributions 

https://www.youtube.com/watch?v=KVLBTho2CG4&feature=youtu.be&list=UUpyA3jv66mB8he1lS2z4ZQw
https://www.fec.gov/help-candidates-and-committees/filing-reports/#reporting-examples
https://www.fec.gov/help-candidates-and-committees/filing-reports/individual-contributions/
https://www.fec.gov/help-candidates-and-committees/filing-reports/political-party-contributions/
https://www.fec.gov/help-candidates-and-committees/filing-reports/pacs-other-political-committee-contributions/
https://www.fec.gov/help-candidates-and-committees/filing-reports/pacs-other-political-committee-contributions/
https://www.fec.gov/help-candidates-and-committees/filing-reports/candidate-contributions/
https://www.fec.gov/help-candidates-and-committees/filing-reports/partnership-contributions/
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Special Categories of Receipts 
 
In-Kind Contributions  
When entering an in-kind contribution, click the “In-Kind” 
box shown at right and add a description.  Note: Checking 
the “In-Kind” box will automatically create the necessary 
balancing entry on Schedule B (the Disbursements tab). 
Use the “Description” field to add a description of the in-
kind received.  Consult the adequate and inadequate 
purpose of disbursement lists when describing the in-kind. 
 
 

 
Candidate In-Kind Contributions  
For candidate in-kind contributions, committees must also 
report information about the ultimate payee (i.e., the 
vendor) as a memo entry. Follow the instructions above 
for entering an in-kind contribution.  Then, go to the 
Summary Page tab, right click on “Line 17 Operating 
expenditures,” and select “New.” Enter the information 
of the ultimate vendor who was paid by the candidate and 
check the “Memo” box.  Use the “Description” field to 
reference the candidate in-kind entry. 
 

 
Reattribution/Redesignation of a Contribution 
Go to the “Receipts” view. 

1. Find the contribution to be reattributed or 
redesignated and right click on it.  Mouse over the 
“Redesignate/ Reattribute.” Then click Reattribute or 
Redesignate in the box that appears. 

 

2. After choosing Reattribute or Redesignate, 
enter the correcting information for the transaction 
and click OK. Note:  Remember to cross reference by 
including the name of the original contributor in the 
description field.  Click OK to return to the “Receipts” 
view. 

https://www.fec.gov/help-candidates-and-committees/filing-reports/in-kind-contributions/
https://www.fec.gov/help-candidates-and-committees/purposes-disbursement/
https://www.fec.gov/help-candidates-and-committees/purposes-disbursement/
https://www.fec.gov/help-candidates-and-committees/filing-reports/-kind-contributions-candidate/
https://www.fec.gov/help-candidates-and-committees/filing-reports/redesignating-and-reattributing-contributions/
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a. For reattribution, highlight the newly created negative entry that FECFile generated for the 
original contributor, then right click and click Modify... 

             
b. Update the description field to include the name of the person to whom the contribution is 

being reattributed. 
3. Click “OK” and then click “Yes” at the prompt. 

 

 
48-Hour Notices (Form 6) 

1. A 48-hour notice is a separate filing from a Form 3. 48-hour notices are required for all 
contribution of $1,000 or more received less than 20 days but more than 48 hours before the day 
of an election. 

2. To prepare to create 48-hour notices, first create the Form 3 that includes the 48-hour notice 
period (please consult page 6 for instructions on how to create a new Form 3 report). 

3. Enter the contribution on the Form 3 report (please 
consult page 13 for instructions on entering a 
contribution). 

4. To create a 48-hour notice, go to the “Reports” view, 
right click, and click New.  Click “48-hour notice 
(Form 6)” and click OK. 

5. The “48-hour notice (Form 6)” box will appear; fill in 
the election date, the state, and enter the treasurer’s 
information in the “Signed by” box.   

6. Click OK.  Note that at this point the notice is not 
complete. 

7. Select the “Reports” view and select the 48-hour notice by left clicking on it.  48-Hour Notice 
instructions continue on the next page. 

https://www.fec.gov/help-candidates-and-committees/filing-reports/reporting-48-hour-notices/
https://www.fec.gov/help-candidates-and-committees/filing-reports/reporting-48-hour-notices/
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8. Select the “All Transactions” view and locate the receipt(s) that needs to appear on the 48-hour 
notice.  Receipts will be sorted by line number and then alphabetical order.  

 
9. After finding a transaction, select the entry, right click, and click Add to Form 6.  Repeat this step 

until all the required contributions have been added to the 48-hour notice.  
         
The 48-hour notice is complete.  Close and upload it in the same manner as a regular report of receipts 
and disbursements (please consult page 25).  Repeat this process if you need to file additional 48-hour 
notices. 
To see when your committee needs to file 48-hour notices, please visit the Dates and Deadline and 48-
Hour Notices pages or contact the Reports Analysis Division (800-424-9530, Menu Option #5). 

 
 
 
Offsets to Operating Expenditures  
To report the refund of a good or service previously 
purchased by the committee, go to the Summary Page tab, 
right click on “Line 14 Offsets to operating expenditures 
(refunds, rebates, etc.)” and select ”New.” Include the 
vendor's name, address, date the refund was received, and, 
in the “Description” field, include a clear description 
connecting the transaction to the original payment. 

 

 

https://www.fec.gov/help-candidates-and-committees/dates-and-deadlines/
https://www.fec.gov/help-candidates-and-committees/filing-reports/48-hour-notices/
https://www.fec.gov/help-candidates-and-committees/filing-reports/48-hour-notices/
https://www.fec.gov/help-candidates-and-committees/question-rad/
https://www.fec.gov/help-candidates-and-committees/filing-reports/offsets-operating-expenditures/
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Contributions Received Through 
Conduits (Earmarked 
Contributions) 

1. Follow the instructions on page 13 to 
report the original contribution. The date 
of receipt is the day that the contributor 
gave the contribution to the conduit. In the 
“Description” field include a note stating 
“Contribution earmarked through [name 
of conduit].” 

 

2. Right click on the original 
contributions and select 
“Transaction Split.” After the 
“Transaction Split” window opens, 
click “Add new” 

 

 

 

3. Enter the conduit information.  The 
date of receipt for this entry will be 
the day that the conduit gave the 
contribution to the committee.  In the 
“Description” field include a note 
stating “Total earmarked through 
conduit. Limit not affected” if the 
conduit did not have direction or 
control over which committee 
receives the contribution. Click the 
OK button when finished.  

 

 

https://www.fec.gov/help-candidates-and-committees/filing-reports/contributions-received-through-conduits/
https://www.fec.gov/help-candidates-and-committees/filing-reports/contributions-received-through-conduits/
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Bundled Contributions 
 

1. Select the “Reports” view and create a Form 3L 
(Report of Bundled Contributions).  Select the 
correct report under “Type of Report,” and input the 
treasurer’s name in the “Signed by” box. 
 
 
 
 
 
 
 
 

2. Once the Form 3L is created, contributions can be added to it by checking the “F3L Bundle” box 
while entering contributions to the Form 3. 

3. To specify the bundler, select the 
Lobbyist/Registrant from the scroll box underneath.  
If the Lobbyist/Registrant does not appear, type the 
name in the “Lobbyist/Registrant Bundler” box and 
hit Enter or Tab, and then input the necessary 
information.  

4. The Lobbyist/Registrant will only appear on the 
Form 3L if the total activity attributed to them 
exceeds the itemization threshold during the 
coverage dates of the Form 3L. 

5.  Close and upload the Form 3L in the same manner 
as a regular report of receipts and disbursements 
(please consult page 25).  
  

  

https://www.fec.gov/help-candidates-and-committees/lobbyist-bundling-disclosure/
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Disbursements 
 
FECFile Video Tutorial: "Entering Operating Expenditures and Staff Reimbursements"  

Disbursement Basics 
1. Go to the “Summary Page” view and double-click on the appropriate line. 
 

         
2. A disbursement box for that line number will appear.  
3. Select the payee’s name from the scroll box below the “Name” 

field.  If the entity is not in the database, press Tab or Enter to 
add the information. Refer to page 11 (“Creating Contributor 
and Vendor entries”) for more information. 

4. Enter the date, amount, and description fields.  Consult the 
adequate and inadequate purpose of disbursement lists when 
filling out the “Description” field. 

5. We recommend filling in the election to more easily calculate 
net debts. 

6. Candidate/Campaign Committee is not required for line 17 
Operating Expenditures. 

7. Category code, Check No., and Account Identifier are not 
required and are only for internal use. 

8. Click OK. 
 
Disbursement Reporting Examples: 

• Operating Expenditures 

• Refunds of Contributions 

• Voided Checks 

• Contribution Made to Other Candidate Committees 

• Charitable Donations 

• Candidate Salary Payments 
 

https://www.youtube.com/watch?v=n2eHPATHv8Q&feature=youtu.be&list=UUpyA3jv66mB8he1lS2z4ZQw
https://www.fec.gov/help-candidates-and-committees/purposes-disbursement/
https://www.fec.gov/help-candidates-and-committees/filing-reports/#reporting-examples
https://www.fec.gov/help-candidates-and-committees/filing-reports/operating-expenditures/
https://www.fec.gov/help-candidates-and-committees/filing-reports/refunds/
https://www.fec.gov/help-candidates-and-committees/filing-reports/voided-checks/
https://www.fec.gov/help-candidates-and-committees/filing-reports/making-contributions-other-candidates/
https://www.fec.gov/help-candidates-and-committees/filing-reports/charitable-donations/
https://www.fec.gov/help-candidates-and-committees/filing-reports/candidate-salary-payments/
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Special Categories of Disbursements 
Staff Reimbursements, Travel Reimbursements, Credit Card & Payroll Payments: 
Payments to credit card companies, payroll companies, and reimbursements all need to list supporting 
memo entries to disclose the ultimate recipient of the funds. Click on the links above for reporting 
examples of each special category of disbursements. 

1. Double-click the desired line of the Summary Page and enter the entity receiving the 
reimbursement or payment.  In the description field, provide an acceptable description, such as 
“Reimbursement,” “Payroll payment,” or “Credit card payment.” 

2. Go to the “Disbursements” view and find the transaction that needs supporting memo entries. 
3. Right click on the transaction and click Transaction Split.   

  
4. Click Add new….   
5. A new transaction window will open.  Fill out the original vendor’s information and click OK 

when finished.  (Note: the “Memo” box is grayed out as the transaction will automatically appear 
as a memo entry.) 

  

6. Repeat this process until all of the supporting memo entries for the payment or reimbursement 
have been entered. 

7. After entering all of the supporting memo entries, click Close to return to the “Disbursements” 
view. 

https://www.fec.gov/help-candidates-and-committees/filing-reports/staff-reimbursements/
https://www.fec.gov/help-candidates-and-committees/filing-reports/travel-reimbursements/
https://www.fec.gov/help-candidates-and-committees/filing-reports/credit-card-disbursements/
https://www.fec.gov/help-candidates-and-committees/filing-reports/using-payroll-company/
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Debts and Loans 
 

Schedule D: Debts 
 
Debts Owed by the Committee: 

1. Select the “Summary Page” view. 
2. To add a new debt owed by the committee, double click on Line 10 (Other Debts Owed BY the 

Committee). 

        

3. Select the name field and enter in the debtor.  If the vendor has not been added to the system, press 
Tab or Enter. Please consult page 11 (“Creating Contributor and Vendor entries”) for more 
information. 

4. Enter the date, amount, and the purpose of the debt in the appropriate fields. 
5. Click OK. 

https://www.fec.gov/help-candidates-and-committees/filing-reports/debts-owed-committee/


 

FECFile Training Manual 
Page 22 

Debt Repayments: 
1. To add debt repayments, go to the “Loans/Debts and Obligations” tab. 
2. Right click on the debt to which you would like to make a payment and click Loan/Debt payments. 

        
3. In the “Loans/Debt payments” box, click on Add new…. 
4. In the “Select the type of Deferred Disbursement” window, click on the line number the payment 

will go on, such as Operating Expenditure [17]. 
5. Enter the name of the vendor, date, amount, and the purpose of disbursement. 

 

6. Click OK.  The debt payment should now appear in the “Loan/Debt payment” dialog box.   
7. Click Close. 

 

https://www.fec.gov/help-candidates-and-committees/filing-reports/debt-payments/
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Schedule C & Schedule C-1: Loans 
 
Loans Received: 

1. Go to the “Summary Page” view and double click on Line 
13(a): Loans received from the candidate or 13(b): Other 
Loans Received. 

2. Type the name of the creditor in the “Name” field.  If the 
creditor has not been entered into the system previously, 
type the name and then press Tab or Enter. 

3. Enter the date the loan was incurred, amount of loan, 
interest rate, election type, year of election, and the loan’s 
due date. If there is no interest rate or due date, enter 
“none” in both fields. Do not leave the interest rate or 
due date fields blank. 

4. If the loan was secured, check the “Secured” box.  The 
committee may also add a description of the loan in the 
“Description” field. 

5. If the loan is from the candidate’s personal funds, 
check the “Personal Funds” box. 

6. If the loan is from the candidate and derived from a bank 
or some other source that is NOT the candidate’s personal funds, click Schedule C-1… and enter 
all information that is applicable to the loan. 

7. If the loan is received directly from a bank or lending 
institution, click on “Schedule C-1…” and enter the 
required information.  Note: If the committee receives 
the loan directly from a bank or lending institution, the 
committee is required to file a paper copy of Schedule 
C-1 with the signature of the representative from the 
lending institution and the treasurer’s signature, as well 
as a copy of the loan agreement. 

8. After completing this section, click OK. 
9. If there are any guarantors, click Guarantors…  
10. Click Add new… to enter guarantor information.  Click 

Edit… if the guarantor has been added previously.  Click 
OK to return to the “Loans Made” screen.  

11. After the loan information is entered, click OK to return 
to the “Summary Page” view.  Schedule A supporting 
Line 13 and Schedule C supporting Line 10 will now 
have amounts reflected on the Summary Page and the 
corresponding schedules will be created on the report. 

Loan Reporting Examples: Candidate Personal Funds Loans, 
Bank Loans Obtained by the Candidate & Bank Loan Obtained 
by the Candidate Committee 

https://www.fec.gov/help-candidates-and-committees/filing-reports/#reporting-examples
https://www.fec.gov/help-candidates-and-committees/filing-reports/candidate-personal-funds-loans/
https://www.fec.gov/help-candidates-and-committees/filing-reports/bank-loans-obtained-candidate/
https://www.fec.gov/help-candidates-and-committees/filing-reports/bank-loan-obtained-candidate-committee/
https://www.fec.gov/help-candidates-and-committees/filing-reports/bank-loan-obtained-candidate-committee/
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Loan Repayments Made: 
1. Go to the “Loans, Debts and Obligations” tab. 
2. Click the loan for which repayment is being made, right 

click, and click Loan/Debt payments… 
3. Click Add New… 
4. Enter the creditor’s name; if the creditor has already 

been entered, select that name.  Type the date, amount, 
and enter “Loan repayment” into the “Description” field. 

5. Click OK to return to the “Loan/Debt Payments” screen, 
then click OK to close that window. Schedule B 
supporting Line 19(a) or 19(b) and Schedule C 
supporting Line 10 will now have amounts reflected on 
the Summary Page and the corresponding schedules will 
be created on the report.   

 
 

https://www.fec.gov/help-candidates-and-committees/filing-reports/loan-principal-and-interest-payments/
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Closing/Uploading/Amending 
 

Closing a Report 
1. Go to the “Reports” tab. 
2. Right click on the report and click Close Report. 
3. Enter today’s date in the “Date closed” field and click OK.  

(Note: a Filing ID is only required when filing amendments and 
should be left blank for new reports.) 

 

Validating and Uploading a Report 
1. First, follow the directions above for closing a report. Closed 

reports should appear in pink/purple in the “Reports” tab. Note: 
You will receive the following valdiation error message if you 
don’t close the report: “Treasurer Signature Date is Required, but field is empty.” 
 
 

  
2. IMPORTANT:  Save the file before validating and uploading! 
3. Click the “File” menu and select Validate a Report or click the Validate icon. 

 
4. The validation program will notify you if there are serious errors that will prevent you from filing 

the report. For more help with Validation Errors, please consult page 30. 
 
 
 
 
 
 
 
 
 
 

 
 

 

https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/
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5. Note:  A report that has errors will not be allowed to upload.  A report with warnings will 
upload, but be advised that warnings indicate some missing information that may be required.  If 
no errors are found or you wish to file the report with warnings, then click the “File” menu and 
select Upload a Report, or click the Upload icon, which is located directly to the right of the 
Validate icon.  
 

 

 
 
6. Enter the password (please consult page 2), 9-digit committee ID number, and email address.  You 

must confirm the password and email address by entering them  a second time or the report will 
not  upload. 

7. Unless otherwise directed by the FEC’s Electronic Filing Office, leave “Web service” as the Filing 
Method and then click Submit Filing to FEC.  (Note: “This filing amends” field should not be 
filled in for new reports.) 

8. Save and back up the committee file after the report uploads. 
9. You will receive a confirmation email if the report is successfully uploaded. If you don’t received 

a confirmation email or are unsure if the report was successfully uploaded, please contact the 
Reports Analysis Division (800-424-9530, Menu Option #5). Successfully filed report can be 
viewed here: https://www.fec.gov/data/filings/?data_type=efiling  
 

 

 

 

 

https://webforms.fec.gov/psa/getstarted.htm
https://www.fec.gov/help-candidates-and-committees/question-rad/
https://www.fec.gov/data/filings/?data_type=efiling
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Amending a Report 
 
Creating an Amendment: 

1. Go to the “Reports” tab. 
2. Right click the report to be amended and then click Amend. 
3. Click OK on the “Report Information” box. 

a. The report will now have an A1, A2, etc. in front of it.  A1 is for the first amendment, A2 is 
for the second amendment, and so on.  If the user has filed any reports with coverage dates 
following the amendment, FECFile will automatically generate amendments for those reports. 
For instance, if the April Quarterly report is amended in November, FECFile will also generate 
amendments for the July Quarterly and October Quarterly reports. 

b. Note: these reports will automatically be generated, but not automatically uploaded.  Also, 
these additional amendments need not be uploaded unless there is a change in any of the dollar 
figures (most commonly: election cycle-to-date, cash-on-hand totals, or aggregate totals).  If 
there are any changes in the dollar figures for subsequent reports, please upload those reports 
as well (please consult page 25). 

 
Modifying Transactions for the Amendment: 

1. Locate the transaction to modify. 
2. Double click on the transaction. 
3. Make the desired changes to the transaction and click 

OK. 
4. When prompted, click Yes to modify the selected report. 

 
Adding New Transactions for the Amendment: 

As with a new report, go to the “Summary Page” view and double click on the appropriate line for 
that transaction. 

 
Deleting Transactions from an Amended Report: 

1. Locate the transaction to delete. 
2. Right click on the transaction and click Delete. 
3. When prompted, click Yes to delete the selected 

transaction. 
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Filing an Amended Report:  
1. An amended report is filed like a new report:  Close the report, and then choose Upload a Report 

from the “File” menu (please consult page 25 for closing and 
uploading instructions). 

2. If the original report was created using FECFile, the software 
will automatically fill out the “Filing ID” field.    

a. Do not alter this number unless instructed by an FEC 
analyst or the FEC’s Electronic Filing Office. 

b. If instructed to alter the number, or if the number does 
not appear in the box, the filing ID is located on the 
FEC’s website (https://www.fec.gov/data/filings/).  
Search the committee’s name or ID number.  The Filing ID appears under the “Version” 
column. 

Filing a Termination Report 

To close down committee operations, a committee must file a Termination Report. Committees can file 
a Termination Report when the committee no longer receives (or intends to receive) contributions and 
no longer makes (or intends to make) expenditures. If a committee is involved in an FEC enforcement 
action, audit or litigation, it cannot terminate. The committee must continue to file reports until that 
matter is resolved. Once the FEC notifies a committee by sending a termination approval letter, the 
committee can stop filing campaign finance reports with the FEC. 
 

1. In the “View” menu, click Reports. 
2. In the “Edit” menu, click New, or right click 

anywhere in the Reports window and click New.  
3. Select “Report of Receipts and Disbursements 

(Form F3)” and click OK. This is the same form 
used to file previous campaign finance reports.  

4. From the Type of Report menu, select “Termination 
Report.”  

5. Enter the “Date From” and “Date Thru.” The “Date 
From” will be the day after the ending coverage 
date of the committee’s last filed report. The “Date Thru” can be the date of last activity by the 
committee or the ending coverage date of the next scheduled report (whichever date is later). 

6. Select the election cycle. Please consult page 4 for more information. 
7. To sign the report, click in the Signed by box.  Enter the treasurer’s name (last name, first name).  

If the treasurer’s name has not already been entered into FECFile, press the Tab key or Enter key. 
8. After all the information is entered, click OK.  
9. Enter transactions on to this report. When finished, you will follow the steps to Close, Validate 

and Upload the report (please consult pages 25-26 for these instructions). 

https://www.fec.gov/data/filings/
https://www.fec.gov/help-candidates-and-committees/reporting-examples/termination-report/
https://www.fec.gov/help-candidates-and-committees/terminating-a-committee/
https://www.fec.gov/help-candidates-and-committees/filing-reports/election-cycle-aggregation/
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Secrets to FECFile 
Common E-Filing Mistakes 
 
Passwords  
• Remember to obtain a password as soon as possible. Due to the extra security requirements, it may 

take up to two business days for the FEC to complete electronic filing password requests. 

• Don’t wait until the last minute to apply for a password or to apply for a new one if necessary. 

• Remember the committee’s password and keep it secure: the FEC cannot look up misplaced or 
forgotten passwords; the Treasurer must request a new one. 

• Please visit the Electronic Filing Password page to request, change or retrieve a password: 
https://webforms.fec.gov/psa/getstarted.htm  

Filing at the last minute 
• Any problem, whether it’s technical or non-familiarity with the software, can be difficult to deal with 

during the rush of a deadline week.  It is advisable to always file as early as possible, especially the 
first time the committee files electronically. 

• Be aware of upcoming reports and consult the Dates and Deadlines page.  

• House and Senate candidate committees file quarterly reports, pre-election reports, 48-Hour Notices 
and post-general election reports. 

• A committee’s obligation to file regular financial disclosure reports continues (even if the candidate 
loses the election or is no longer seeking office) until the committee requests to terminate and that 
request is approved by the FEC. 

Email receipts confirm filing has been received. 
• After uploading the report electronically, a receipt will be sent to the email address entered when 

uploading the report.  Assume that the report was not successfully filed if no receipt is received. Call 
the Electronic Filing Office (202-694-1642, Option #3) if more than a few minutes pass without 
receiving a receipt. 

• The receipt is proof of filing.  Print it out and keep it. 

• You can look up your committee’s filings at any time using the FEC website: 
https://www.fec.gov/data/filings/?data_type=efiling 

Save and validate data set early and often 
• Doing this through the process of report creation will ensure proper and consistent data entry as well 

as preventing the loss of work due to unforeseen computer problems, i.e. freezes, crashes etc.  

Back up the data file! 
• The file that contains all of the committee’s reports, the “Data File” (.dcf), should be backed up to an 

external source. 

• The FEC does NOT have a copy of your data file! 

• It is very difficult and time consuming to recreate the committee file if it is lost. 

https://webforms.fec.gov/psa/getstarted.htm
https://www.fec.gov/help-candidates-and-committees/dates-and-deadlines/
https://www.fec.gov/help-candidates-and-committees/filing-reports/quarterly-reports/
https://www.fec.gov/help-candidates-and-committees/filing-reports/pre-election-reports/
https://www.fec.gov/help-candidates-and-committees/filing-reports/48-hour-notices/
https://www.fec.gov/help-candidates-and-committees/filing-reports/post-general-election-reports/
https://www.fec.gov/help-candidates-and-committees/terminating-a-committee/
https://www.fec.gov/help-candidates-and-committees/filing-reports/rebuilding-data-file/
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Common Validation Errors and How to Fix Them 
 

Warning vs. Error Messages 
There are two different types of validation errors: warning messages and error messages.   
Warning messages: 
These messages are a result of possible incorrect/missing information in the report so the user can correct 
the issues (if necessary) before uploading the report.  However, they do not prevent the committee from 
uploading a report.  
Error messages: 
These messages result from more serious problems with the report and prevent the user from uploading 
the report until the errors are corrected. 

Reading and Understanding a Validation Message 
Each warning or error message contains basic information that allows the user to pinpoint which 
transaction is causing the issue.  It also gives a brief description of the error.  For example: 
 

Form{Item}:  SA11AI   {Johnson, Jane} 
Field Name:  #012  Employer 
Warning     Conditionally Required Field is Empty 

 
The Form {Item} field identifies where the transaction causing the error is on the report.  In the example 
above, the transaction is on Schedule A, Line 11(a)(i) and is specifically identified as “Johnson, Jane.”  
Field Name identifies the aspect of the transaction – in this case the employer field – that is causing the 
problem.  The last line identifies what type of message this is (Warning) and describes what caused the 
problem (Required field is Empty). 
 
In order to correct this problem, the user should find the specific transaction and edit it to disclose Jane 
Johnson’s employer. 
 
The FEC’s website includes a more extensive list of commonly found warning and error messages along 
with brief descriptions and solutions: 
https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/  
  

https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/
https://www.fec.gov/help-candidates-and-committees/filing-reports/validation-errors-explained/
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Common Error Messages 
Below is a list of common error messages that committees encounter and the steps that need to be taken 
in order to correct the errors.  Please remember that all error messages must be corrected before you can 
upload your report. 
 

Treasurer Signature Date is Required, but field is empty 

• This error indicates that you have not closed the report. From the Reports tab, highlight and 
right-click on your report, and chose “Close Report…”. The Close Report window will appear 
where you must enter a date, generally the day you close and submit the report (please see page 
25) 
 

Treasurer: Last Name is Required, but field is empty 
Treasurer: First Name is Required, but field is empty 

• This error indicates the treasurer’s name was not selected.  From the Reports tab, highlight and 
right-click on your report and click “Modify.”  Enter or select the treasurer’s name in the 
“Signed by” field. 

 
{Contributor First Name} is Required, but field is Empty 

• Contributions from individuals (Schedule A transactions) must contain a first and last name. 
If this error has occurred, the first name of the contributor has been omitted or incorrectly 
submitted in conjunction with the wrong Entity Type (individual, organization, business, etc.). 
Locate the transaction and correct the name. 

• From the “Individual/Organizations and Events” tab, scroll down (listings are alphabetical) 
until you find your contributor. Double-click to open up the profile. Enter in the first name of 
the contributor if missing or check the first field to verify that you have chosen from the drop-
down menu the entity type of “Individual other than candidate”. 

 
{Recipient First Name} is Required, but field is Empty 

• Disbursements to individuals (Schedule B transactions) must contain a first and last name. If 
this error has occurred, the first name of the individual has been omitted or incorrectly 
submitted in conjunction with the wrong Entity Type (individual, organization, business, etc.). 
Locate the transaction and correct the name. 

• From the “Individual/Organizations and Events” tab, scroll down (listings are alphabetical) 
until you find your individual. Double-click to open up the profile. Enter in the first name of 
the individual if missing or check the first line to verify that you have chosen from the drop-
down menu the entity type of “Individual other than candidate”. 

 
Filing must be in the current FEC format 

• This indicates that you are using an outdated version of FECFile. 
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• FECFile users will need to download the latest version of the software from the FEC's website 
(https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/). 
Amended filing must have an ID of the "Original"  

• This indicates that the user is trying to submit an amendment absent the original report ID number. 
The original report ID number must be used.  If you are properly amending existing reports in the 
committee file, the original filing ID should appear automatically. 

• If the user cannot locate his receipt for the original report, the ID number can be located on the 
FEC's Electronic Filing Report Retrieval website under the “Version” column 
((https://www.fec.gov/data/filings/). 

• Once you have located the original filing ID, you will need to 
open, and then re-close your report so you can enter the filing ID.  

• NOTE: If this original report ID number is entered incorrectly, 
system errors will occur on upload. 

 
Amended filing must have an "Amendment Number"  

• This means that either the 
amendment indicator is missing or 
incorrect.  The first amendment 
will be A1, and each subsequent 
amendment will be numbered in 
sequence.    

• This error most likely occurred 
because you did not properly create an amendment or amended 
a report before it was filed. 

• Don’t amend a report that you have not uploaded.  FECFile 
will warn you with this message – click Cancel.  
 

• In the “Reports” view, right click on the report you are trying 
to file.  If the report is closed, unclose it.  Right click again and 
click Unamend. 
 

• Repeat this process until your report is at the correct numbered amendment 
 
Validation terminated! – Over 32,000 problems found!  

• This indicates that 32,000+ errors have been found.  The threshold for total errors for the system 
is 32,000; therefore, the first 32,000 errors will be listed in accordance with their severity. 

• If you receive this message please contact your FEC analyst or the FEC Electronic Filing Office. 

 
 

https://www.fec.gov/help-candidates-and-committees/filing-reports/fecfile-software/
https://www.fec.gov/data/filings/
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ID# _________ NOT correct FEC ID# format  

• This indicates that the committee ID number 
used is not in the correct format. 

• To correct this error, you will need to edit 
your committee’s information.  To do this, go 
to the “Individuals/ Organizations” view and 
locate your committee.  Double-click on your 
committee entry (it should be in red).  Make 
sure the committee ID number is correct.  It 
might help to use the FEC Lookup feature. 

• NOTE: (correct example: C00123456) - The 
“C” must be capitalized. 

 
Extraneous data follows last field  

• This usually indicates a technical problem, generally involving invalid characters. 

• You should call the Electronic Filing Office if you receive this error (202-694-1307). 

• NOTE: Only characters between ASCII 22 and ASCII 126 are acceptable.  The ASCII 32 - 126 
used to be the only characters allowed; however, the foreign language alphabet and punctuation 
characters are also allowed. Specifically ASCII characters: 32 - 168 are allowed (excluding 127 
and the series 157 through 159).  Also, 173 is allowed. 

 
Invalid double-quote surround text field – OR - Embedded double-quotes (") not allowed  

• This indicates that there are a set quotes around a text field where there should not be. 

• Locate the transaction/field and take out the quotes. 

• NOTE: Quotes are used as part of the data delimiter.   Since the introduction of a level-8 message 
that says "Embedded double-quotes (") not allowed", this message only applies to the very last 
field of a CSV string and only in the instance where a begin-quoted text is not terminated with an 
end-quote. (Example: falling within the maximum length of that last field.) 

• ADDITIONAL NOTE: Any field can have begin/end quotes (they are necessary for text that has 
embedded commas). However, any field that has surrounding quotes may not also contain double 
quotes anywhere within the text.  Validator is only trapping "embedded quotes" within "text fields" 
which have surrounding begin-quotes and end-quotes. For example [,""",] is a case of an embedded 
double-quote, but [,",] is not. 

 
Body of text exceeds maximum of 20,000 characters (F99 filings) 

• F99 (Miscellaneous text document) filings are limited to 20,000 characters in length. 

• To correct this, either shorten your Form 99 filing or file more than one. 
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Leading blanks {e.g. " TEXT"} not allowed  

• This indicates that there are blanks prior to data; this is not allowed. 

• Locate the transaction/field and delete the spaces that precede the first word in the file. 
 
Bad date – ________ not YYYYMMDD format  

• This indicates the user has entered a date in the incorrect format. 

• Locate the transaction and re-enter the date trying this format: MM/DD/YYYY. 
 

________ is not a real date  

• This indicates that the user has entered an invalid date. 

• Locate the transaction and enter a valid date. 
 
Invalid amount format: ____________ – OR – Non-numeric data in numeric field 

• This indicates that the user has entered values other than numbers 
and decimals. 

• Locate the transaction and enter only numbers and one decimal 
point.  FECFile will issue a warning before this error is made.  

• NOTE: Dollar signs and commas are not permitted. 
 
____ is an invalid year (CCYY) format  

• This indicates the user has entered the year in the incorrect format. 

• Locate the transaction and make sure the year referenced in the date field is in a four-digit format. 
 
District "__" is not 2-digit numeric format  

• This indicates the user failed to enter the congressional district as two digits. 

• Locate the transaction, and make sure the congressional district field has two digits (ex: 04, 11).  
Using the FEC Lookup feature might make things easier. 
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Electronic Filing and Reporting Resources 
 
Electronic Filing Resources 
 
FECFile for Candidate Committees Video Tutorials: 
https://www.youtube.com/watch?v=yI8AYiaOErA&list=PLJr_nRe8SzD3ZnN8o-af5idxz2F9Ohk53  
 
Electronic Filing Password: https://webforms.fec.gov/psa/getstarted.htm  
 
Online Webforms: https://webforms.fec.gov/  
 
Electronic Filing Overview: https://www.fec.gov/help-candidates-and-committees/filing-
reports/electronic-filing/  
 
Importing Data into FECFile: https://www.fec.gov/help-candidates-and-committees/filing-
reports/importing-data-fecfile/  
 
Rebuilding a Data File: https://www.fec.gov/help-candidates-and-committees/filing-reports/rebuilding-
data-file/   
 
Validation Errors Explained: https://www.fec.gov/help-candidates-and-committees/filing-
reports/validation-errors-explained/  
 
Upload Errors Explained: https://www.fec.gov/help-candidates-and-committees/filing-reports/upload-
errors/  
 
Recently Filed Reports Search: https://www.fec.gov/data/filings/?data_type=efiling   
 
Reporting Resources 
 
Reporting Dates & Deadlines:  https://www.fec.gov/help-candidates-and-committees/dates-and-
deadlines/   
 
Help for Candidates and Committees: https://www.fec.gov/help-candidates-and-committees/  
 
Campaign Guide for Candidates and Committees: https://www.fec.gov/resources/cms-
content/documents/candgui.pdf  
 
Candidate Reporting Examples: https://www.fec.gov/help-candidates-and-committees/filing-
reports/#reporting-examples  
 
Inadequate & Adequate Purpose of Disbursement Lists: https://www.fec.gov/help-candidates-and-
committees/purposes-disbursement/  
 
FEC Training, Webinars and Conferences: https://www.fec.gov/help-candidates-and-
committees/trainings/  
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